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1 Introduction

You use SAP Cloud Integration to establish the communication with Portugal Tax Authority Web Service to
perform Register, Cancel and Finish operations on Document Series Identifiers. This document describes the
setup steps that you must perform in your SAP S/4HANA or SAP ERP system and SAP Integration Suite tenant so
that the integration between the systems works.

The setup steps are typically done by an SAP Integration Suite consulting team, which is responsible for
configuring the SAP S/4HANA or SAP ERP and the connection with SAP Integration Suite. This team may be also
responsible for maintaining the integration content and certificates/credentials on the SAP Integration Suite
tenant.

1 Note

This document describes functionality that is provided by the Integration Package itself, that is, by the artifacts
that are deployed in the SAP Integration Suite tenant. It may happen, however, that in the SAP S/4HANA or SAP
ERP system the access to such functionality is only partially implemented. Additionally, it may also happen that
the tax authority servers do not provide all services that are described in this document. Please refer to the
relevant SAP S/4HANA or SAP ERP documentation and to the relevant tax authority information, respectively.
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2 Prerequisites

Before you start with the activities described in this document, ensure that the following prerequisites are met.

1. You have installed in the test and productive systems all necessary SAP Notes for the Portugal Manage Series
Validation Code Solution.

2. You have set up your tenant as follows:

o If you have subscribed to Process Integration, perform all the initial setup steps described the initial setup
steps described in Initial Setup of SAP Cloud Integration in Cloud Foundry Environment.

o If you have subscribed to Integration Suite, perform all the initial setup steps described in Initial Setup.
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3 Configuration Steps in SAP Integration
Suite

Required steps in SAP Integration Suite.

3.1 General Information

The package SAP S/4HANA Integration with Portugal Tax Authority Web Service contains the following integration
flow.

Integration Flow Name in WebUI Project Name/Artifact Name

Manage Series Validation Code com.sap.GS.Portugal.ManageSeriesValidation

3.2 Adding User Credentials

Context

To authenticate the request to the tax authority you need to add user credentials to the security materials.

Procedure

1. Gotolr Operations View > Security Material » Add » User Credentials & and enter the User ID and password
to connect to the tax authority with the following alias:

User Credentials

Value Description

<taxcode>_portugaldocseriescredentials To connect to the tax authorities’ services

1 Note

e Enter your tax code as a prefix for the credential.
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Create User Credentials

Name: * |_ortuga Idocseriescredentials|

Description: ‘

Type: * ‘ User Credentials v

Password: |

User:* ‘ ‘

Repeat Password: ‘

Deploy Cancel

VAT number can have multiple sub-users, but one Cl tenant can handle only one sub-user.

Related Information

Configuring Integration Flow

3.3 Deploying Key Pairs

Context

You deploy the key pairs to the SAP Integration Suite tenants. You need separated key pairs for testing and
production environments.

Procedure

Contact SAP to request the necessary key pairs for authentication, which include
portugaldocseriestestdgita.pl2 and portugaldocseriesproddgita.pl2. Refer Note 3137385 to
download the Key Pair.

Upload the new private key in the Keystore app. Go to I» Operations View # Keystore » Add > Key Pair 1

You must upload the portugaldocseriestestdgita.pl2 and portugaldocseriesproddgita.pl2 filesto
the keystore of the tenant. Create the alias for the key pair according to the following naming convention:

Value Description
portugaldocseriestestdgita.pl2 Test environment
portugaldocseriesproddgita.pl2. Production environment
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Related Information

e Adding User Credentials [page 7]
e Configuring Integration Flow [page 10]

3.4 Uploading the Root Certificate

Provides a description on how to upload the root certificate to the keystore of your SAP Integration Suite

Integration tenant.

Procedure

1. Gotothe web site of the tax authorities (Portal das Financas).
2. Choose the icon next to the URL and select Certificate.

o InChrome (Recommended)

Your information (for e asswords or credit

card numbers) is private when it 15 sent to thas site

* Flash

0 Site sethings

o Inlinternet Explorer
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‘e @ https://
)

j”' i Website Identification

This connection to the server is encrypted.

Should | trust this site?

View certificates %

3. Inthe Certificate window, go to the Certification Path tab, choose the root certificate (first in the tree) and
then choose View Certificate.

a Certificate X

General Details | Certification Path

Certification path

1
View Certificate

Certificate status:

This certificate is OK.

4. Goto the Details tab:

To ensure that you are downloading the correct Certificate, check the values of Valid from and Valid to.
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p  Certificate

General Certification Path

Show  <All> ~

Field Value
E]Version |
[=]serial number ]

[] signature algorithm
[|signature hash algorithm
[~]1ssuer :

[T]valid from
[F]valid to

[=]Subject

Edit Properties...

Copy to File...

5. Ifeverythingis up to date, choose Copy to File and save it to your local directory.

6. GotoKeystore on your SAP Integration Suite tenant to upload the saved root certificate.

) Discover
Overview
& Design
@ Monitor Manage Integration Content
%Q Settings

All

55

Manage Security

All All

54

Stared Error

Security Material Keystore Access Policies User Roles
4
Artifacts Entries Artitacts
7. Choose Monitor, select Certificate, and then Add.
(5 Discover
Overview / Manage Keystore
# Design
@ Manitor Current Backup New SAP keys SAP Key History ;,';eﬁiﬂ??%,
Settings Key Pair
o 8 Entries (39) Filter by Alias or DN Y Ada =
SsHKey |
Alias ‘ Keystore Type
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Add Certificate

Alias: * | |Enter an alias for the certificate |

File: * | Choose a certificate for upload... |[ Browse... ]

Cancel

3.5 Copying Integration Flow

Context

Copy the integration flow in the package SAP S/4HANA Integration with Portugal Tax Authority Web Service to the
target tenant as follows:

Procedure

1. Inyourbrowser, go to the WebUI of the tenant (URL: /itspaces/shell/catalog).

2. Choose Discover All.

. Discover

HIGHLIGHTS (11) ALL (83)

3. Searchfor SAP S/4HANA Integration with Portugal Tax Authority Web Service. Select the Package and choose
Copy.

SAP Cloud Platform Integration Data Services 'ii:’ )

(%]
............. & . A
4 Discoved/ L

Related Information

e Configuring Integration Flow
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3.6 Configuring Integration Flow

Context

You configure the package that you have copied as described in Copying Integration Flow.

Procedure

1. Thereis one Artifact in the integration package SAP S/4HANA Integration with Portugal Tax Authority Web
Service.

Choose IFActions #Configure £for the artifact you are configuring.

Choose [FConfigure #More 4 tab (in some versions it may be Externalized Parameters). Use the Mode
parameter to set up the integration package usage mode: Use the Address parameter to set up the
integration package address. Normally you don't have to change this field. In case you change the field, make
sure to use the same address when configuring the logical ports in the next chapter.

Value Description
TEST To use the test system of the tax authority
PROD To use the prod system of the tax authority

Configure “Manage Series Validation Code”

4. Choose l*Configure #Sender 4 tab.

o Usethe Address parameter to set up the integration package address. Normally you don't have to change

this field. In case you change the field, make sure to use the same address when configuring the logical
ports in the next chapter.

o Use the User Role parameter to configure the role based on which the inbound authorization is checked.
Choose Select to get a list of all available roles. The role ESBMessaging. send is provided by default.
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Configure "Manage Series Validation Code

Connection

manage_senes_validaton

of Role ESBMessagng send

5. Based on your mode of deployment, choose TEST or PROD.
Configure "Manage Series Registration"

Sender More

Type: ‘ All Parameters

<TEST/PROD>: | TEST

Save Deploy Close

6. Choose Save and Deploy to deploy it actively to server. Note down the URLs of the endpoints for each service.

1 Note

Depending on the version of your tenant, after pressing these buttons, a warning messages can appear.
You can ignore these messages by choosing Close. The first two warnings are related to the payload
attachments; currently the Series Validation process does not support or require message attachments
(for example, scanned copies of invoices) in any stage of processing and communication.
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4 Configuration Steps in SAP ERP or SAP
S/4HANA

The following sections tell you the necessary configuration you do in SAP S/4HANA or SAP ERP.

4.1 Create Logical Ports in SAP ERP or SAP S/4HANA

Proxies must be connected to the SAP Integration Suite tenant via logical ports. In the SAP ERP  or SAP
S/4HANA test system, the logical ports are configured to connect to the test SAP Integration Suite tenant. In the
productive SAP ERP or SAP S/4HANA system, the logical ports are configured to connect to the productive SAP
Integration Suite tenant.

Proceed as follows:

1. Inyour SAP ERP or SAP S/4HANA system, go to transaction SOAMANAGER and select Web Service
Configuration.

Service Administration Technical Administration Logs and Traces Management Connections Services
|dentifiable Business Context
Define Identifiable Business Contexts (IBCs)

Identifiable Business Context Reference
Define Identifiable Business Context references (IBC reference)

Design Time Cache
Display central design time cache

Web Service Configuration
Configure service definitions, consumer proxies and service groups

Simplified Web Service Configuration
Configure service definitions for Web service consumers with limited capabilities

Logon Data Management
Define logon data used by business scenario configuration

Pending Tasks
Process pending tasks generated by business scenario configuration

Local Integration Scenario Configuration
Configure multiple service definitions and service groups supporting change management

Logical Determination of Receiver using ServiceGroups
Define rules for determining receiver IBC reference during service group runtime

Logical Determination of Receiver, Sender, and Authentication using Consumer Factories
Define rules for determining receiver IBC, sender IBC reference and authentication method during consumer factory runtime

Web Service Isolation
Tool to isolate service definitions and consumer proxies

2. Search for the proxy for Portugal with the search term CO_GLO_PT SERIES_VAL_COMM.
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~ Search criteria

| Obiect Type v]e v A v 00
| Object Name v contains v ] ©6e

Maximum Number of Resulls: | 100 § Enter the search term herej

Clear values | Resel search criteria

3. Intheresultlist, select a proxy and create a logical port for it. Choose Create and Manual Configuration.

Define Logical Ports

Create

Set Log Port Default = | Activate

.

-

WSDL Based Configuration

Manual Configuration
Process Integration Runtime
Local Shortcut Configuration
Service Registry Based Configuration
Template Based Configuration

WSDL based Configuration with Template

4. Enteralogical port name and a description. Select the Logical Port is Default checkbox.

— QO OO © ©

Logical Port Name Consumer Security HTTPSettings SOAP Protocol Identifiable Business Context Operation Settings

Next Cancel

General Configuration Settings

Logical Port Name:* | Logical Port is Default: :

Description: | |

5. The Consumer Security configuration depends on the security being used for the SAP ERP or SAP S/4HANA -
SAP Integration Suite communication.
o If you use the basic authentication, enter the value of the CclientID for Username, and the value of
client secret for Password. You create these values for your service instance in SAP Integration
Suite. See Creating Service Instances.
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New Manual Configuration of Logical Port for Consumer Proxy '( )

» 1 n 3 4 5 6 -

Logical Port Name Consumer Security HTTPSettings SOAP Protocol Identifiable Business Context Operation Settings

Back Nexi Finist Cancel
Configuration of Consumer Settings without WSDL Document. LP=
Authentication Level: Basic

Authentication Settings

* User D/ Password
SAP Authentication Asserfion Ticket
X.509 SSL Client Certificate

User ID/Password

User Name:

Password:

o If you use certificate-based authentication, choose X.509 SSL Client Certification and select the
certificate you have uploaded to STRUST. You must configure this certificate in SAP Integration Suite too.
For that you create a service instance using the required grant type. You create the service key using the
certificate uploaded to the STRUST. For more information, see Defining a Service Key for the Instance in
the Cloud Foundry Environment. (Refer Section 4.2)

6. Onthe HTTP Settings tab page, select the URL components radio button and make the following settings:

Setting Value
Protocol Select HTTPS
Host Enter the host name of the integration flow that you want to

communicate with

Port Enter 443, which is the standard port for the HTTPS protocol

Path Find the path of the related integration flow from your SAP Cloud
Integration tenant or SAP Integration Suite tenant

To find URL, go to SAP Cloud Integration Web Ul, do as follows:

1. From the menu on the left, choose the Operations view.

2. Choose Manage Integration Content (All).

3. Search for the integration flow for the scenario you are configuring.

4. Find the host name from the Endpoints tab. The endpoint URL is a concatenation of host name and

path: https://<host name>/<path>.
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ENOPOINTS  STATUSDETAILS  ARTIFACT DETAILS
i Goto Operations View [rv'L:' > ]
STATUS DETAILS copy the url from here
el Fries the iFlow name as search ferm
The Flow is deployed successtully

ARTIFACT DETALLS

Mondor Message Processing

View Integration Flow

The entries for the Proxy fields depend on your company's network settings. The proxy server is needed
to enable the connection to the Internet through the firewall.

7. Onthe Messaging tab page, set the value of the Message ID Protocol field to Suppress ID Transfer.

» 1 2 3 [ 4 ] 5 6 -4

Logical Port Name Consumer Security HTTPSettings SOAP Protocol Identifiable Business Context QOperation Setlings

Back || Next || Finish || Cancel |

Message ID (Synchronous)

Message 1D Protocol: I Buppress ID Transfer ~ I

Metering of Service Calls

Data transfer scope Enhanced Data Transfer
Transfer protocol: Transfer via SOAP header -

Message Attachment Handling

Process Attachments: | No e

8. No settings are required in the tabs Identifiable Business Context and Operation Settings. Just choose Next
and then Finish.

4.2 Upload the Certificates

Store the public certificates used for your productive and test tenants.
Context

You use the SAP ERP Trust Manager (transaction STRUST) to store and manage the certificates required to
support connectivity between SAP back-end systems and SAP Cloud Integration.
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Procedure

Access transaction STRUST.

Navigate to the PSE for SSL Client (Anonymous) and open it by double-clicking the PSE.
Switch to edit mode.

Choose the Import certificate.

S N

In the Import Certificate dialog box, enter or select the path to the required certificates and choose Enter. The
certificates are displayed in the Certificate area.

o

Choose Add to Certificate List to add the certificates to the Certificate List.
Save your entries.
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